
Need Art? Use Cookie Cutter!

HyperStudio has always included 
the most advanced art tools of any 
multimedia program I’ve used.

Hopefully you've tried out the new 
HyperStudio 5® color and image 
effects, which are accessed by 
choosing the Effects tool in the 

lower right corner of the Tools palette. Two factors greatly 
increase the utility of these effects: You can vary the 
strength of the effect, and you can apply it either to the 
entire background or to a selected object. 

However, you may have missed a powerful tool that was one 
of the few fancy effects in older HyperStudio versions. 
Cookie Cutter is easy to overlook 
with all the new options. It is 
especially powerful when combined 
with the newer art effects. In this 
tutorial we'll do just that, and 
turn a sketch into an amazingly 
realistic background picture.

Begin With This Sketch...

Make This Picture!



Meet A Golden Oldie
Two legacy options, Cookie Cutter and Image Effects, can be accessed 
under the Edit menu.  I'll do a separate tutorial on Image Effects 
eventually, but for now, I want to introduce you to Cookie Cutter.  

Take a sneak peek under Edit now. Look down 
the list of options and pick Effects. These 
two legacy options will pop up, but Cookie 
Cutter may be grayed out. We are about to 
find out when Cookie Cutter can be used, 
and how to use it.

Once you know how to use Cookie Cutter, 
it's easy to transform a simple sketch into a 
work of art within HyperStudio. Besides 

tools, we also need materials in the form of texture photos that can be 
downloaded free from a website called, logically, textures.com. 

Textures For MY Students??
Textures are used mostly by professional 3D artists to make amazing 
realistic images, often animated. That's far too complex for young 
students, so perhaps you've never considered using them for class 
projects. Prepare to be surprised at what can be done with texture 
photos in HyperStudio!  

I haven't included the texture files for you to download with this 
tutorial for two reasons. First, this way you will get a quick tour of the 
textures site and learn how to find things on it. 

Second, textures.com’s terms of use don’t allow redistributing sets of 
their textures, although anyone can sign up for an account and 
download the small and medium sizes of any image FREE. These are 
high quality photos, so this is a very generous arrangement!
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Go to textures.com now, and set up your free account. I’ve had my 
account for many years, and I can promise you that you won’t be 
bombarded by email ads :) Once you have your free account set up, 
download the four images listed in the following table. 

The first words in each line of the table are the categories you click 
from the sidebar, followed by which thumbnail to click, followed by the 
image name. When each texture opens, click and download the small 
size. Put all four texture .jpg files into one folder, so it will be easy to 
drag them into the cards.  Okay, that’s all we need to get started. Let’s 
make a picture!

A Stack Is An Infinite Sketchbook
Start HyperStudio 5 and make a new stack. Set the card size to 1024 
x 768 pixels. Load my sketch (sketch1024x768.jpg) as the card 
background on Card 1, where we’ll create a realistic background picture. 
Open the Card Index, as we’ll be moving between cards often.

Please remember, if you share this tutorial or give a workshop using textures 
from this site, to ask people to download their own materials. Marcel 
Vijfwinkel, who started textures.com in 2005, confirmed to me that you are  
allowed to make multiple copies to use in classes.
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Categories Thumbnail Location Filename

FX/Water/Plain              3 rows down, 3rd from left WaterPlain0007_S.jpg             

Landscapes/Green 
Mountains

9 down, 3rd from left  MountainsGreen0049_1_S.jpg

L a n d s c a p e s /
Skies Partial

6 rows down, 2nd from left          Skies0304_S.jpg

Nature/ Grass 9 rows down, 2nd from left     Grass0038_1_seamless_S.jpg
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For this tutorial, I painted four large solid 
areas for the sketch: a band of distant 
mountains, a green foreground area, a blue 
water area, and the sky area which I left 
white.  We will use Cookie Cutter to put 
part of each texture photo into those 
areas.

Once you have the sketch loaded as background in Card 1, Copy 
the card and Paste it four times, a total of five cards. Our 
next step is to place one of the the texture photos on each of 
the duplicate cards, positioning each so that it covers the part 
of the sketch where it will appear in the finished picture. 

Card 2: Sky 
On Card 2, drag in the sky texture. 
Notice that the dragged-in image becomes 
a graphic object, so it is easy to change its 
size and position. Resize the sky image so 
that it covers the card from the top edge 
down past the mountains skyline.  Placement 
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Tip 3: The four duplicated cards can be deleted once the picture is finished. 
They are just handy places to park the textures. You also can use extra cards 
as scratch paper to draw elements for a scene, alter clip art, and prepare 
frames for animation.  Discard these scratch cards before saving the finished 
stack. A stack really is like an infinite sketchbook!

Tip 2:  If you chose to paint more areas for a starting sketch, you 
would need to choose and download more textures, one per area. This 
technique works best with large solid areas. Smaller elements can be 
painted or pasted in after the main sections are in place.
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doesn’t need to be precise, just so you have sized the image big enough 
to cover from the card top edge down past the lowest point of the 
mountains skyline. 

Since the sky photo is much wider than its height, you have the option 
of sliding it left and right until a part of the sky 
you like is over the card. 

Flatten it into the background. Don’t worry about 
the part of the sketch that still shows. The 
sketch on this card is there only as a guide in 
placing the texture. When we use Cookie Cutter, 
the template piece will be positioned completely 
on the sky area.  

Card 3: Mountains
Drag the mountain scene into Card 
3, and resize it to cover the band 
of mountains. Again, you can 
adjust it right or left. Flatten it 
and check that the sketched 
mountains are covered completely.

I noticed a gray structure, maybe a concrete pipe, in the mountains 
photo that I didn’t want in my final 
picture. I decided to use a patch to hide 
it. I selected a small area just below the 
gray object and about the same size with 
the Freeform Lasso and Copied it. I 
Pasted the patch, moved it over the gray 
structure, and Flattened it to the 
background to cover the gray strip. 
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Card 4: Grass
For Card 4, Drag in the grass photo. When I 
dragged it in, it was much too small to cover 
the entire grass area in the sketch. I didn’t 
want to stretch it out of shape because the 
flowers might look strange. In fact, the 
flowers looked too big to match the picture. 

I needed to do some resizing and duplicating. Luckily, the grass photo 
is a seamless texture, so I knew copies would match up nicely.

I shrunk the grass photo until its height covered the band of grass, 
then I copied and pasted it. I moved the copy to the side until the 
edges lined up. You can nudge a selection one pixel at a time using the 
keyboard arrows. I had to line up two copies to make a wide enough 
piece of grass to cover all green areas. 

Then I selected all three copies, and used Objects-->Merge Selected 
Objects to create a single strip I could move into place easily. Since it 
covered the green part of the sketch with room to spare, I rotated it 
a little bit just for fun before I flattened the grass.  Rotation is more 
necessary if there is something like a fence in the texture you want to 
see on a slant.  Use any tools necessary to prepare the texture before 

Tip 4:  A patch won’t show if you copy it from an area that’s close in colors to 
the area you plan to patch, and if the patch has slightly uneven, lassoed edges. 
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Tip 5:  It’s easy to line things up perfectly if you turn on Smart Guidelines in 
HyperStudio Preferences-->Layout. Lines appear across the top, middle, and 
bottom when you have the two images lined up just right. You can move the two 
images close and then move them one pixel at a time with the keyboard arrows, 
until the guidelines flash on.
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flattening it into background. That way you can just cut out and paste 
part of it into the picture. 

Card 5: Pond
Okay, three texture pages all done!  I purposely 
chose textures that needed various tweaks, but 
for young students, you don’t need to be that 
picky. Often resizing and/or stretching is plenty 
good enough.

For the pond, I simply dragged in the water 
photo, resized and stretched it to cover the blue 

part of the sketch, and flattened it to the background.  The water 
doesn’t have a specific form, after all, and the ripples or little waves 
can be stretched and still look natural.

Okay, that takes care of the slow part.  Time to save the 
stack! You don’t want to have to do all that again.

Two Suggestions: A Template Or A Kit
For young students or those with physical challenges, you might want to 
set up things to this point as a template. You could have separate 
stacks with different starting sketches, and different textures on the 
“cookie dough” pages. You’ll see in the next part why I call them that.  

For older or more physically agile students, you could assemble a folder 
of textures for them to use to make original pictures. I’d suggest 3 or 
4 skies, maybe one a sunset, grass with and without flowers, desert, 
beach sand, green mountains, snowy mountains, low hills, craggy rocky 
formations, calm water, little ripples water, and ocean waves. With 
that as a kit, they could design most scenes.  

For a specific report, they might need a few more textures, perhaps 
logs to depict a fort,  a specific structure such as a pyramid, etc.  Once 
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you show them how to drag a texture to a scratch card, select an area, 
copy it, paste it onto the texture, and pick it up using Cookie Cutter, 
students will take off and create amazing art.

Cutting And Flattening The Sky
Now, at last, we can use the Cookie Cutter! Move back to the 
sketch card (Card 1). Get the Expanding Lasso by double-
clicking the lasso on the Tools palette to open the drawer, 
and choosing the middle of the three lassos in the drawer.

Click in the white (sky) area of the sketch. The lasso 
expands to fill that area. Copy the selection, move to Card 2 
(sky texture), and Paste. DO NOT DESELECT!  Look under 
the Edit menu, move down to Effects, and choose Cookie 
Cutter. Sky fills your selection. to cut the cookie (the sky 
piece), and put it onto the clipboard. 

Move back to the sketch on Card 1, click 
anywhere on the card, and Paste. Before 
deselecting, check that the sky is covered--you 
can resize it a teeny bit if needed. To flatten 
the sky, you need to click anywhere outside the 
sky selection, so click in the mountain area 
since you need to select it next. 

Cutting and Flattening the Mountains
Copy the selection in the mountain area of the sketch, and move to 
Card 3, the mountains texture. Paste, again being careful not to 

Tip 6:  I advise clicking on the card because that seems to open the card to 
additions of objects. Otherwise, since the card icon is selected in the Card 
Index when you first move to the card, Paste creates a duplicate of the entire 
card instead of pasting what is on the clipboard.

©2016 ann brundige studio  www.annbrundigestudio.com
A HyperStudio 5® lesson from Annie’s Resource Attic

Feb 13, 2017! 7

http://www.annbrundigestudio.com
http://www.annbrundigestudio.com


deselect. Go up to Edit/Effects/Cookie 
Cutter again. Copy the mountain selection.

Return to Card 1, click the card, and Paste 
again. This paste should put the mountains 
piece in place just below the sky, as if 
assembling a puzzle. Again, you can enlarge 
the piece a teeny bit before deselecting, if 

you see a white line at the join between sky and mountains. This time, 
click in the grass area to flatten the mountains piece into the 
background and select the grass area all at once.

Cutting and Flattening the Grass
Copy the selection in the grass area of the 
sketch, then go to Card 4, the grass 
texture. Paste, again being careful not to 
deselect. Go up to Edit/Effects/Cookie 
Cutter again. Copy the grass “cookie”.

On Card 1, click the card, and Paste again. 
The paste should put the grass piece in place just below the mountains. 
This time, click in the pond area to flatten the grass piece into the 
background, and select the pond area at the same time.

Cutting and Flattening the Pond
Copy the selection in the pond area of the sketch, then go to Card 5, 

the water texture. Paste, again being 
careful not to deselect. Go up to Edit/
Effects/Cookie Cutter again. Copy the 
water selection.

Return to Card 1, click the card, and Paste 
again. This paste should put the water piece 
in place over the blue pond area of the 
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sketch. You can press Enter/Return this time to deselect and flatten 
the pond water into the background. 

DEFINITELY time to save the stack!

Background Picture Built 
From Textures Photos
At this point we have a 
complete picture, one that 
could be used as is  by younger 
students. With the addition of 
a few bits of clip art, this 
image could illustrate a story 
or a report. Students might 
also use it as a background for 
an animation.  

Use As Ready Made Card
If the picture is finished at this point, one way to keep it handy for 
use is to delete the four scratch cards and then save the single card 
stack as a Ready Made Card. The option Save As Ready Made Card 
is under the File menu.  

HyperStudio allows saving Ready Made 
Cards in folders other than default, and 
will automatically add a link in the 
default Ready Made Cards folder so 
that a newly saved Ready Made Card 
appears in the list.  That means you can 
set up a folder for each student in 
which to save their art masterpieces, 
and they can retrieve the cards for 
later use in their projects.  
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I tested this option by making a 
folder called My Ready Made Cards 
on my computer desktop. I deleted 
the four texture cards from a copy 
of my art stack, then saved the 
remaining card with the completed 
scene into my new folder.  I used 
Save To Ready Made Cards... and 
MountainSceneBackground.stack  as 
the name.

Then I looked under Edit/Ready Made Cards. A long list of standard 
Ready Made Cards that come with HyperStudio opened, followed by a 
line, and just under that was my MountainSceneBackground! 

Optional Final Touches
For students who are proficient at using the art tools and effects, 
here are four final touches to make the scene look even more realistic. 
These changes make use of the Brush, Spray Can, and the Effects 
Tool.  While optional, making one or more of these changes adds details 
that turn the sketch into real artwork. It’s a good idea to duplicate the 
card with the textured scene and do these changes on a copy. 

Paint Reeds In The Pond
The edge of the pond will look more natural if there are some plants in 
the water.  Let’s paint in some reeds!  We don’t have to paint the leaves 
one at a time, because there is a brush that will do a whole clump at 
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one click.  Get the brush tool now, and choose the 
grass brush. Set it for a large size.
First we’ll paint in a back row of plants, mostly 
shadows. Choose a tan or brown color.  Also set the 
opacity to 64%, so that these shadowy plants won’t 
look solid.

Click the brush at points along the edge of the pond 
to make plants.  You can make short down drags, too, 
but try to make many clumps. Don’t try to line them 

up; a messy line of plants looks more natural. Make the plants come out 
further in some spots. For taller plants, click at pond level and a little 
higher in the same spot so the upper leaves are taller. Vary the size 
setting so the plant sizes won’t all be the same.

Okay, now let’s do the front row. Choose a dull green 
this time, and make sure the opacity is 100%. Splat 
more clumps of plants on top of the shadow plants. You 
might want to change greens so these more distinct 
leaves will vary in color. Do the darker colors first.

Finally, let’s put some shadows onto the water. First, 
get the finger paint brush and set it for a small size. 
Open the drawer, click the colors squares, and get the 
eyedropper. Sample one of the darkest parts of the 
pond. This will be a dull, dark green. Click the colors 
circle icon to the right of the current color box to open 
the Colors palette, and make the green a little darker. 
Also set a lower opacity, about 50%.

Make short straight strokes at the base of the reeds, going a little 
way into the water. The shadows will match perfectly, and blend nicely 
into the water because we used a darker shade of a color we know is 
part of the pond.
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The reeds cover the boundary 
between the water and grass 
textures, making the pond look 
like it is lower than the grass 
and adding interesting details.  

Compare this scene with the 
added reeds to the scene with 
added textures only. Now it’s 
beginning to look like real 
artwork!             SAVE NOW!

Darken The Distant Grass
This is a very easy finishing touch, but an important one. 
It gives the picture its sense of distance. We filled in 
the area between the bottom of the artwork and the 
distant mountains with a grassy meadow texture, 
complete with flowers. However, in the real world, we 
would not see each grass blade and flower distinctly in 
the far distance.  

All we need do to add that distance blur is to paint in 
dots of one of the darker colors in the grass.  Pick the 
color by sampling the grass with the eyedropper tool until 
your current color is a very dark green. We chose one of 
the colors in the grass, so we know that our painted dots 
will blend in.

For a brush, get the Finger Paint brush again, but this time we’ll use it 
in a special way.  Instead of sliding the brush to make smeared lines, 
we will just click once in each place. Each click will add a small cluster 
of dark green dots, just what we want!   Click the brush about every 
inch across, starting half an inch below the mountains.  
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On the next row closer to the mountains, click the dot clusters closer 
together, and keep doing that right up to the bottom edge of the 
mountains. Just as when we painted the reeds, we don’t want things 
lined up perfectly. Plants like to grow in raggedy lines. Your last line of 
clicks should overlap the bottom edge of the mountains a tiny bit, 

creating an uneven edge.

That’s good; it disguises the 
sharp boundary line where we 
pasted in texture pieces.  The 
dark green dots hide some  of 
the flowers in the distance, 
making them seem farther 
away.                SAVE NOW!

Add More Flowers Up Close
This effect is also easy, and it is just the reverse of 
darkening the distant grass.  We might expect to see 
flowers that look bigger very close to us in the picture. We 
also might be able to see colors other than the bright 
white that would stand out farther away. 

HyperStudio makes it very easy to add these extra 
flowers.  Choose the Spray Can, open the drawer, and 
there is a flower shape ready to spray!  We’ll have to be 
careful to do a very quick spray, just a click, for each 
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bunch of flowers. We’ll also want to keep them close to the bottom of 
our picture and not add too many.

Use a small size for the flower spray, and add a few bright blue and 
yellow flowers near the pond. You can do them all with the flower brush 
set to a small size, or you can use several different sizes and shapes. 

Try changing the spray size a 
little bit between clicks. You 
also could do some sprays with 
the star shape, and maybe one 
with the dust, spatter, or oil 
drops shapes.

Adding just a few extra 
f l o w e r s t o t h e p i c t u r e 
brightens it up and makes it 
your own.  I added yellow and 
blue flowers, but maybe you 

like red, pink or orange.  Bringing colorful flowers close to the edge of 
the picture on the left  adds a focal point.                        SAVE NOW!

Blur The Skyline (Your Final Exam)
The fourth finishing touch is the most involved, but I think it’s worth 
doing. Not only will it improve this mountain scene, but it also teaches 
you about how to get the most from the Effects tool. 

The mountain tops would be very distant in a scene like this, so far 
away that dust and moisture in the air would make the skyline look 
slightly blurred.  Because we pasted in a selection from the mountains 
texture, our mountains have an unrealistically sharp edge. Fortunately, 
there is a Blur tool built into HyperStudio. It’s one of the options for 
the Effects tool, but we must do lots of planning before using it.
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The Effects tool can be used either on the entire background, or on a 
graphic object. If we use the blur effect on the background, the entire 
picture will blur, but we only want to blur the top edge of 
the mountains. If we find a way to select the just skyline 
area, the selection still is not a graphic object. We need to 
select the mountain skyline, turn that selection into a 
graphic object, blur it, and somehow change it back into 
part of the background picture.  Think we can do it?

Let’s break this complicated problem into easy little parts. 
First, we’ll tackle selecting the strip along the mountain 
tops. Which tool should we use? We need to select an 
irregular shape that isn’t a solid color from an area that 
also isn’t a solid color. Neither the expanding lasso nor the 
regular lasso will do that easily, and certainly not the 
square or circular selectors.  We need the Pencil Lasso.

To get this tool, double-click on the lasso, the third tool on the top row 
to open the drawer at the bottom of the Tools palette.  We’ve done 
this before to get the expanding lasso, but we need a different lasso 

this time. Choose the Pencil Lasso, the third 
lasso from the left.  

Draw with the Pencil Lasso all along the 
skyline close to the mountain tops, down to 
just beneath the skyline, and all the way back 
across below the skyline, before letting up on 

Tip 9: Three different lasso tools handle three kinds of selections, though 
all three are for freeform shapes.  The simple Lasso is best for a complex 
item with a fairly wide solid area surrounding it. The Expanding Lasso is best 
for a solid area within a complex background. The Pencil Lasso lets you 
select a custom shape where there are no handy solid areas.
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the mouse button to let the 
selection join up. Copy and 
Paste the selection but DON’T 
DESELECT it and don’t move it. 
Your selection should be a 
skinny wiggly shape across the width of the picture just at the top of 
the mountains.

The next step is to make this strip of background into a graphic 
object. With the skyline still selected, go up to the Objects menu and 
choose Convert To Graphic Object.  Now you have a graphic object of 

the skyline, but underneath it, the original 
picture is unchanged. We can apply effects to 
the graphic object, and if things get ugly, we 
can delete it without messing up the picture. 
Leave the graphic object selected, and don’t 
move it. Remember where it is and what is 
included within it, because what we do next 
will hide its outline.

Now for the magic part! Double-click the Effects tool. It’s the magic 
wand tool in the lower right corner of the Tools palette. 
The outline of the graphic object disappears when you 
choose the Effects tool.  Since you chose Effects with a 
double-click, the drawer opens. The many options for this 
tool are listed under two tabs, Image and Color, at the top 
of the drawer. Click Color, choose Blur, and set Strength to 
Low using the slider at the bottom of the drawer.

Be careful with this next step, but if it messes up, 
remember that you can use Undo to fix it. Click the 
Effects tool once, exactly on the top of the highest 
mountain. Really, you could click anywhere on the graphic 
object, but that spot is part of it for certain. You should 
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see a thin strip along the mountain tops blur. If everything except that 
strip blurs, fix it by clicking Undo and try again.

Okay! That was the hardest part. Now we have to make the blurred 
strip part of the background 
again. Get the Arrow (Edit) 
tool and click on the graphic 
object to select it, or you 
could select it from the 
Objects Browser.  

Check to make sure it is still 
exactly in its place across 
the mountain tops, and nudge 
it into position if needed. 
C h o o s e F l a t t e n T o 

Background from the Objects menu.  You’re done!             SAVE NOW!

This procedure may seem complicated, but once you see how it works, 
you can do it quickly and easily.  To review, you select using the Pencil 
Lasso, copy and paste without moving or deselecting, convert the 
selection to a graphic object, choose an effect and set its strength, 
click in the graphic object with the Effects tool, re-select the graphic 
object, and flatten it back into the background. 

The best part? It’s not just for applying Blur. It’s a general procedure 
for applying ANY of the Image or Color effects controlled by the 
Effects tool to a selected portion of the background. 
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Nice Enough To Frame

If you compare our final background picture with the starting sketch, 
surely you will agree that it’s a real work of art, and nice enough to 
frame.  Just think how proud your students will be when they create 
something like this!  In case they might really wish they could frame 
their work, here is one last set of tricks.  Move to the very last card in 
the Great Art stack, and you’ll see the picture we just created in a 
fancy frame I made within HyperStudio!  Here’s how to do it.

At the beginning of this tutorial, I mentioned that Cookie Cutter is one 
of two legacy special effects you can access from the Edit menu.  In 
passing, we noticed the name of the second one, Image Effects, on the 
same pop-out menu as Cookie Cutter.  It’s a bit confusing, because we 
have also used a different, newer set of Image Effects operated by 
the Effects tool.  The legacy Image Effects include an extra set of 
tools you can use alone and also combine with the Effects Tool options.  
To make a frame, we are about to make repeated use of one of the 
legacy effects, the Beveler.

The first step in making our frame is to make a new blank card on 
which to work, so do that now.  Next, we want to fill the card with a 
material that will make a good frame. We don’t need a 
photo such as we used for the picture, but instead the 
overall type of pattern or texture you can pour with the 
Paint Bucket.  Double-click the Paint Bucket now to 
choose it and open the drawer of options.  

Click the third button in the second row of the drawer 
to bring up the patterns options. Some of the commonly 
used textures are displayed below that button, but to 
open the main list of presets, click the third button on 
the top row of the drawer, the one that has three 
overlapping rectangles. The Colors palette should open 
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with the Textures Presets displayed; if not, 
click the last button on the right at the top.  

Scroll down and choose the blue leather 
texture. It’s just below a texture with red 
hearts.  Of course, you could pick a different 
texture than the one I used, but for this 
project, choose one with a fairly simple design, 
perhaps a wood pattern, rather than something 
with large picture elements like those hearts.

Pour the blue leather texture with the Paint 
Bucket to fill the blank card.  Double-click the 
Square Selector to select the entire card.  Go up 
to the Edit menu, move down to Effects, open the 

pop-out menu to the right, 
a n d c h o o s e I m a g e 
Effects.  The dialog that opens will have a 
tabs for a set of six tools: Beveler, Emboss, 
Texturizer, Brightness/Contrast, Replace 
Colors, and Gradients.  These are the art 
effects from older HyperStudio versions, and 
they all are worth trying out. For now, click 
the tab for Beveler.

Tip 11: The Choose button on the Textures Presets panel lets you load a 
pattern file from your own folders, which you can use with the Spray Can, 
Brush, or Paint Bucket. Search online for seamless textures in .png or .jpg 
format, and download the smallest sizes from sites such as textures.com.  I 
was able to choose a 1024 x 1024 texture and pour it into a card with the Paint 
Bucket, but if possible get smaller images. They don’t have to be square, just 
seamless. If the pattern looks too large, resize the entire texture picture in a 
graphics program and save the smaller size. That way it will still be seamless.
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There are only three settings for Beveler, but with them you can make 
an amazing array of complex borders.  First, you can set the width 
from a very narrow line to a width meeting in the middle of a shape.  
You can get some idea of what this setting will do by looking at the 
Preview, but the actual effect depends on the size of the shape, 
usually a rectangle, which you are beveling. 

Next, there is a checkbox labeled Rounded.  If this is left empty, the 
beveled edge will be a sharp, flat surface.  If checked, you get an 
arched, rounded surface, bending up or down depending on the next 
setting.  The third setting is another checkbox labeled Raised. If this 
box is left open, the frame will appear to be recessed, while it would 
appear to protrude out of the card if you check the box.

For the first bevel on this frame, leave both 
checkboxes open, and set a width of 50. 
Click OK. Zap! It’s beveled! We are about to 
do a second bevel, not as wide as this one, 
but first let’s think about how best to work 
with Beveler.  

You can use either of two strategies when 
doing multiple bevels: The easiest way is 
work from the inside out, doing the widest 
bevel first so later ones don’t wipe out the 
inner edge.  

Alternately, you can select rectangular 
areas to bevel.  If you try that, be sure to 

turn on the grid in Preferences. The grid lines make it easy to select 
evenly close to edges.  Set the grid lines so that you have an even 
number of squares or rectangles across and up and down. For example, 
with these 1024 x 768 cards, I set the grid to 32 pixels between lines. 
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Let’s go on to the second bevel.  Still on the card 
with our blue frame, go once again to Edit--
>Effects-->Image Effects. Click the Beveler 
tab again. This time, set the width for 15 pixels, 
and for the Style, click both Rounded and 
Raised.  Click OK again. Zap! The frame is done!

Because we did not have a selection, 
Beveler worked on the entire card, 
creating the bevel around the outside 
edge.  This second bevel wiped out a bit 
of the first one, but most of the first 
wide recessed bevel is still visible. The 
second bevel painted a narrow, slightly 
raised, rounded bead around the very 
outer edge, giving it a finished look.  

Our frame looks sharp, doesn’t it? This is really a very simple frame. 
Experiment with Beveler, and you will soon far surpass this first 
effort.  Try preparing a card with a contrasting band a short way in 
from the edge, using two pattern fills, and then putting multiple bevels 
on it.  Warning: Don’t try this if you have an important appointment 
later on.  You’ll forget to go!

Okay, now we need to prepare a COPY of our finished artwork to go 
into the frame. Copy and Paste the card that holds your finished 
picture, with whatever finishing touches you added. Since the picture 
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is as big as the outer part of the frame, we 
know that we need to resize it so it can fit 
into the frame’s center, leaving the fancy 
beveled edge and perhaps a border around 
the image. 

Double-click the Square Selector to select 
the entire background. Go up to the Objects 

menu, and choose Convert To Graphic Object.  Use the corner handle 
to resize the graphic object while retaining its aspect ratio 
(proportions). You can get a good idea of the size you want by roughly 
centering it on the card.  

When you have the size adjusted to your liking, 
open the Beveler one more time.  Be sure you 
have the graphic object with your artwork 
selected.  Set the width to 10, click the box 
for Rounded, but leave the Raised box empty. 
Click OK.  This puts a thin, engraved edge 

a r o u n d 
your picture.

Copy the picture, move to the card 
with the frame, and Paste. You can 
adjust the size and position if 
needed. Activate Smart Guides in 
Preferences to center the picture.  
Lock the graphic object in place. 
         Time to save the stack!

Exportation Options
There are many ways to show off beautiful student artwork like this, 
using the Export options in HyperStudio.  We’ve already talked about 
the option to save a finished background as a Ready Made Card and 
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later pull it into a project.  Saving as a Ready Made Card is also an 
option with framed artwork. Be sure to delete all cards except the art 
before you Save To Ready Made Cards.  I 
save everything, just in case, so I’d copy the 
finished art card, save the work stack, and 
then Paste the finished art into a new, one 
card stack to save as a Ready Made Card. 

Another way to save artwork is to Export your one card 
stack as an Image Sequence. It may sound odd to use this 
option with a single card, but it is an easy way to save the 
art on a card as a .png file. The advantage is that you can 
use such images in other applications. Simply copy the 
finished art into a new, one card stack, and choose Export 
under the File menu.

A dialog will open with a long list of possible 
export formats.  Choose the bottom one, Image 
Sequence.  You will get a chance to navigate to the 
folder of your choice before saving. This option 
will save either a single image or an image for each 
card in a stack. 

Whether you create a portfolio by saving as 
Ready Made Cards or individual .png files, the 
next step would be to assemble you finished 
artwork into an Art Gallery Stack.  You could show 
this stack as a slideshow or give a presentation 
with comments about each image. Using Export, you can format your 
art collection as a Podcast or QuickTime Movie, a Mac application, or a 
Web Application.

When you’re ready, invite one and all to an exciting exhibit of the great 
art your students made in HyperStudio!
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This tutorial was downloaded from Annie's Resource Attic and is copyright 2017 by 
ann brundige studio. You may make and distribute as many copies as you want, but 
must include this page. You may not sell this activity, nor use any of its elements 
for commercial purposes. For details regarding this Creative Commons license, see 
the Terms of Use section of the web page at www.annbrundige studio.com .

This tutorial requires HyperStudio® and an internet connection to download the 
following texture photos from textures.com:

• Grass0038_1_seamless_S.jpg
• MountainsGreen0049_1_S.jpg
• Skies0304_S.jpg
• WaterPlain0007_S.jpg
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